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                                                                                                        Purpose statement 

 

This general module describes the performance outcomes, skills and 

knowledge required to make part modelling, views, sections, assembly and 

upgrade the hand drafting documentation skills with AutoCAD and Solid works 

CAD software. Additionally, this is module is useful to support learning within 

the specialization of some core modules. 
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Learning Unit 1 – Analyze the CAD work. 

LO 1.1 – Introduce CAD. 

Content/Topic 1: Definition and History of Computer Aided Design (CAD). 

CAD (computer-aided design) software is used by architects, engineers, drafters, artists, and 

others to create precision drawings or technical illustrations. CAD software can be used to 

create two-dimensional (2-D) drawings or three-dimensional (3-D) models. 

CAD is the use of computer software to design and document a product’s design process. 

Engineering drawing entails the use of graphical symbols such as points, lines, curves, planes 

and shapes.  Essentially, it gives detailed description about any component in a graphical 

form. 

The beginnings of CAD can be traced to the year 1957, when Dr. Patrick J. Hanratty 

developed PRONTO, the first commercial numerical-control programming system. In 1960, 

Ivan Sutherland MIT's Lincoln Laboratory created SKETCHPAD, which demonstrated the 

basic principles and feasibility of computer technical. 

In most engineering and archectural offices drafters and designers produce technical 

drawing using CAD systems . A CAD system consists of a personal computer (PC) or 

workstation coupled with a CAD software program, One of the most widely used CAD 

software program is called AutoCAD. 

When AutoCAD was introduced in 1982 it was one of the first CAD programs that could 

operate on PC. Aotodesk the parent company that publishes AutoCAD software, reports 

that there are now millions of AutoCAD  user worldwide. The price for a single station of 

AutoCAD for a professiona ser is about $4700,but at the present time ,Autodesk offer free 

downloads of AutoCAD 2017 and other CAD product to students ,educators , and 

educational institutional at its website; www.autodesk.com/education/home. 

There are many other CAD programs on te market as well. Some CAD program are designed 

to perform wok in a specialzed area. In Mechanical design ,Inventor ,Creo, and Solidworks 

are three of principles CAD program, in electronics design, cadense ,and mentor are widely 

used. In the civil and archetectural field ,land desktop, civil 3D and Microstation are poular 

CAD. 

Content /Topic2: Application of CAD. 

- CAD is widely used in the area of engineering. 

- Is important in chips building, aerospace industries, automotive industries, textiles 

industries and architectural industries. 

- It is used for manufacturing, planning, computer aided analysis. 

- When it comes to material requirements, CAD inventory control and production 

planning, you can always use CAD. 

http://www.autodesk.com/education/home
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- It also helps in purchasing, manufacturing, planning and several other activities. 

 

Content /Topic3: Types of CAD Software. 

a) 2D CAD software: AutoCAD: AutoCAD is a computer-aided design (CAD) program 

used for 2-D and 3-D design and drafting. AutoCAD is developed and marketed by 

Autodesk Inc. and was one of the first CAD programs that could be executed on 

personal computers. 

b) 3D CAD Software: ArchiCAD: ArchiCAD is architectural BIM CAD software for 

Windows developed by the Hungarian company Graphisoft.ArchiCAD offers 

computer aided solutions for handling all common aspects of aesthetics and 

engineering during the whole design process of the built environment buildings, 

interiors, urban areas, etc. 

c) Artlantis: Artlantis is a family of stand-alone rendering applications developed for 

architects and designers. Artlantis Render is designed for those wanting high-

resolution 3D renderings, while Artlantis Studio is ideal for quickly and easily creating 

high-resolution 3D renderings. Recognized and recommended by leading software 

developers, Artlantis is compatible with models designed using most 3D software. 

Artlantis is the rendering software used by architects, designers and urban design 

professionals in more than 80 countries. 

d) Plot maker: plot maker was a lay outing that was part of the ArchiCADpackage. This 

standalone application was optimized to prepare an architectural documentation set 

based on the views, drawings and images created in ArchiCAD. Plot maker could also 

accommodate data from external sources such as other CAD and image files, word 

processing documents and spreadsheets. Since ArchiCAD 10 the Plot maker is 

integrated into ArchiCAD. Thus, no ore separate layout files are needed. 

Plot maker is primarily a sheet layout and numbering tool. Most of the task you will 

perform I Plot maker involve laying out viewports on a page, and cropping them to 

size. Plot maker will sequentially number you sheets and fill in most of your section 

& details references. 
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e) Solid Works: Solid Works is a solid modelling computer-aided design (CAD) and 

computer-aided engineering (CAE) computer program that runs on Microsoft 

Windows. Solid Works is published by Dassault Systems. 

Initially based in Waltham, Massachusetts, United States, Hirschtick recruited a team 

of engineers with the goal of building 3D CAD software that was easy-to-use, 

affordable, and available on the Windows desktop. 

 

LO 1.2 – Select appropriate CAD software. 

Content/Topic 1: Advantages and disadvantages of CAD. 

Advantages Disadvantages 

- CAD Reduced storage space. 

- Corrections can be made easily. 

- Repetitive parts of the drawing can be saved 

and imported as part of a “CAD library.” 

- CAD systems can be linked with CAM 

machines to produce objects straight from 

the drawings. 

- 3D CAD designs can be made to look realistic 

by using the material library for clients to 

see. 

- CAD designs can be easily shared between 

companies or department using email. 

- CAD can be used to create simulated 

environments to show the client. 

- Work can be lost if the computer 

crashes. 

- Work could be corrupted by viruses. 

- Work could be stolen or hacked. 

- Time taken to learn how to use the 

software is too much. 

- Initial costs of buying a computers 

system are high. 

- Time and cost of training staff. 

- Continual need for updating software or 

operating systems. 

- CAD/CAM systems mean less people 

need to be employed. 

 

 

 

Content/Topic 2: Application of AutoCAD and ArchiCAD software’s. 

AutoCAD is a 2-D and 3-D computer-aided drafting software application used in 

architecture, construction, and manufacturing to assist in the preparation of blue prints and 

other engineering plans. Professionals who use AutoCAD are often referred to as drafters. 

AutoCAD is a commercial computer-aided design (CAD) and drafting software application. 

Developed and marketed by Autodesk, AutoCAD was first released in December 1982 as a 

desktop application running on micro-computers with internal graphics controllers. 

AutoCAD application ArchiCAD application 

- AutoCAD is used worldwide across industries 

by architects, engineers, town planners and 

many experienced professionals. 

- It helps in applying different 3D modelling 

- Used for Virtual Building Modelling. It 

has specific building tools like walls, 

slab, door, windows, etc. It is also used 

to create 2D/3D models. 
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techniques to create robust 3D models of 

products and their parts. 

- AutoCAD aids the user to create and design 

better buildings, deliver scalable and feasible 

infrastructure assignments, manage 

production cost and predict project 

outcomes. 

- In AutoCAD the users are able to control the 

appearance of the materials attached to the 

3D models, they can view lighting and 

shadows in their scenes, thus helping them in 

attaining much realistic renders of 3D 

models. 

- Section planes one of the best features of 

AutoCAD, which helps to obtain cross-section 

view of 3D objects. These sections planes aid 

in examining the mirror details of 3D objects 

that helps them to cut through solids, surface 

meshes and regions. 

- A special feature in AutoCAD is that the user 

gets to link the tables. Within their 2D 

drawings directly to Microsoft Excel 

spreadsheet, with this feature they can even 

import formulas and data from excel into the 

table. Also, this feature has an auto update 

default setting. 

- The user can also import Pdf files into 

AutoCAD; they can import 2D geometry, true 

type text also. 

- Any non-Autodesk 3D models’ geographic 

locations and online maps can also be 

imported into AutoCAD. 

- Used for product designing, civil 

infrastructure, 2D drawings, drafts, 

documents, as well as 3D models. 

- ArchiCAD is a very important program 

as it is the first application that 

includes both 2D/3D geometry and 

BIM program as well. 

- This software is used for real-time 

editing and communication which 

helps in boosting the overall BIM 

experience of the user. It allows aids in 

working more progressively and 

competently. 

- This software is a master in workspace 

arrangements and the only widely-

used functions are displayed. Rest all 

the functions are saved as favorites. 

- ArchiCAD is a smooth application for 

its use in 2D zooming and panning 

experience, despite any complexity. 

- ArchiCAD enhances multiple workflows 

and productivity. The enhancements 

deliver realistic buildings, designs, 

accurate construction documentation, 

and precise cost estimations. 

- With ArchiCAD, the user gets a façade 

design workflow that boosts to 

develop, design and detail hierarchical 

curtain wall systems with a lot of 

simplicity. 

 

 

LO 1.3 – Configure CAD Software’s. 

Content/Topic 1: Scale. 
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In technical drawings objects are often drawn to scale. This term refers to relationship 

between the size of the object in the drawing and the actual size of the object after it’s 

manufactured. Following are four of the scales most commonly used in the creation of 

mechanical drawing: 

A. Full scale: this means that the size of the objects in the drawing will be the 

same size as the object after it is manufactured. This is usually only feasible on 

smaller objects such as machine parts. When noting on a drawing that the 

object is drawn full scale, the drafter may write 1=1, 1/1 or 1:1. 

B. Half scale: this means that the size of the objects in the drawing is half the size 

of the object after it is manufactured. The drafter will still place the full-size 

dimensions on the views of the object so that even though the drawing is half 

size, the part will be manufactured full size. When noting on a drawing that the 

object in drawn half scale, the drafter may write 1=2, 1/2, 0.5x, or 1:2. 

C. Quarter scale: this means that the size of the object in the drawing is on four 

the size of the object after it is manufactured. The drafter will still place the full-

size dimensions on the views of the object so that even though the drawing is 

one-fourth size, the part will be manufactured full size. When noting on a 

drawing he object is drawn quarter scale, the drafter may write 1=4, 1/4, 0.25x 

or 1:4. 

D. Double scale: this means that the size of the object in the drawing is twice the 

size of the object after it is manufactured. The drafter will still place the full-size 

dimensions on the views of the object so that even though the drawing is twice 

the size, the part will be manufactured full size. This scale is used for small 

objects that would be difficult to dimension if drawn at actual size. When 

noting on a drawing that the object is drawn double scale, the drafter may 

write 2=1, 2/1,2xor 2:1. 

Following are two of the scales most commonly used in the creation of architectural 

drawings: 

A. Quarter inch equals one foot: this means that every 1/4 “on the plotted 

drawing represent a measurement of 1” on the actual construction project. 

B. Eighth inch equals one foot: this means that every 1/8 “on the plotted drawing 

represent a measurement of 1” on the actual construction project. 

 

Content/Topic 2: Projection. 

a) First angle projection: The object is imagined to be in first quadrant, the object is 

lies between the observer and plane of projection, the plane of projection is 

assumed to be non-transparent, when views are drawn in their relative position 

top view comes below front view, Right side view drawn to the left side of 

elevation. 



Page 8 of 100 
 

 
b) Third angle projection: The object is imagined to be in third quadrant, the plane of 

projection lies between the observer and object, the plane of projection is assumed 

to be transparent, when views are drawn in their relative position top view comes 

above front view, Right side view drawn to the right side of elevation. 

 

Content /Topic 3: Unit configuration MKS and CGS. 

The Unit Configuration feature is a sub-system that describes the structure of an assembled 

electromechanical system. The Unit Configuration feature also monitors components 

modelling to support the management of a single part of interest, or a complex assembly 

that consists of a hierarchy of monitored items. 

Unit system: 

✓ MKS: MKS is the system of units based on measuring lengths in meters, mass 

in kilograms, and time in seconds. MKS is generally used in engineering and 

beginning physics, where the so-called cgs system (based on the centimeter, 

gram, and second) is commonly used in theoretic physics. 

✓ CGS: The(centimeter-gram-second) system of units (abbreviated CGS) is a 

variant of the metric system based on the centimeter as the unit of length, 

the gram as the unit of mass, and the second as the unit of time. For 

example, the CGS unit of force is the dyne which is defined as 1 g. 

 

Content /Topic 4: Standard sheet size of paper setting. 

a) ISO standards: The International Standard Organization (ISO), the international 

paper size standard is ISO 216. It is based on the German DIN 476 standard for 

paper sizes. ISO paper sizes are all based on a single aspect ratio of the square root 
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of 2, or approximately 1:1.4142. There are different series, as well as several 

extensions. 

 

The following table shows the width and height of all ISOA and B paper formats, as well as 

the ISO C envelope formats. The dimensions are in millimeters: 

A Serie Formats B Serie Formats C Serie Formats 

Format 
Width × 

Height (mm) 

Width × 

Height (in) 
Format 

Width × 

Height 

(mm) 

Width × 

Height (in) 
Format 

Width × 

Height 

(mm) 

Width × 

Height (in) 

2A0 1189 × 1682 46.8 × 66.2       

4A0 1682 × 2378 66.2 × 93.6       

A0+ 914 × 1292 36 × 50.9 B0+ 1118 × 1580 44 × 62.2    

A1+ 609 × 914 24 × 36 B1+ 720 × 1020 28.3 × 40.2    

A3+ 329 × 483 13 × 19 in B2+ 520 × 720 20.5 × 28.3    

A0 841 × 1189 33.1 × 46.8 B0 1000 × 1414 39.4 × 55.7 C0 917 × 1297 36.1 × 51.1 

A1 594 × 841 23.4 × 33.1 B1 707 × 1000 27.8 × 39.4 C1 648 × 917 25.5 × 36.1 

A2 420 × 594 16.5 × 23.4 B2 500 × 707 19.7 × 27.8 C2 458 × 648 18 × 25.5 

A3 297 × 420 11.7 × 16.5 B3 353 × 500 13.9 × 19.7 C3 324 × 458 12.8 × 18 

A4 210 × 297 8.3 × 11.7 B4 250 × 353 9.8 × 13.9 C4 229 × 324 9 × 12.8 

A5 148 × 210 5.8 × 8.3 B5 176 × 250 6.9 × 9.8 C5 162 × 229 6.4 × 9 

A6 105 × 148 4.1 × 5.8 B6 125 × 176 4.9 × 6.9 C6 114 × 162 4.5 × 6.4 

A7 74 × 105 2.9 × 4.1 B7 88 × 125 3.5 × 4.9 C7 81 × 114 3.2 × 4.5 

A8 52 × 74 2 × 2.9 B8 62 × 88 2.4 × 3.5 C8 57 × 81 2.2 × 3.2 

A9 37 × 52 1.5 × 2 B9 44 × 62 1.7 × 2.4 C9 40 × 57 1.6 × 2.2 

A10 26 × 37 1 × 1.5 B10 31 × 44 1.2 × 1.7 C10 28 × 40 1.1 × 1.6 

A11 18 × 26 0.7 × 1 B11 22 × 31 0.9 × 1.2    

A12 13 × 18 0.5 × 0.7 B12 15 × 22 0.6 × 0.9    

A13 9 × 13 0.4 × 0.5 B13 11 × 15 0.4 × 0.6    

 

b) ANSI standards:  It is an American National Standards Institute that applies widely 

which defined a regular series of paper sizes based standard letter size which it 

assigned ANSI A. This series includes ANSI A, ANSI B, ANSI C, ANSI D, ANSI E, ANSI 

F, ANSI G, ANSI H, ANSI J, ANSI K. It is somewhat similar to the ISO 216 standard in 

that cutting a sheet in half would produce two sheets of the next smaller size. 
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ANSI Sizes mm cm inches 

ANSI A 216 × 279 21.6 × 27.9 8.5 × 11 

ANSI B Ledger 432 × 279 43.2 × 27.9 17 × 11 

ANSI B Tabloid 279 × 432 27.9 × 43.2 11 × 17 

ANSI C 432 × 559 43.2 × 55.9 17 × 22 

ANSI D 559 × 864 55.9 × 86.4 22 × 34 

ANSI E 864 × 1118 86.4 × 111.8 34 × 44 

ANSI F 711 × 1016 71.1 × 101.6 28 × 40 

ANSI G 279 × 572–2286 27.9 × 57.2–228.6 11 × 22.5–90 

ANSI H 711 × 1118–3632 71.1 × 111.8–363.2 28 × 44–143 

ANSI J 864 × 1397–4470 86.4 × 139.7–447 34 × 55–176 

ANSI K 1016 × 1397–3632 101.6 × 139.7–363.2 40 × 55–143 

c) DIN standards: DIN(Deutsches Institut for Normung). German Institute for 

Standardization develops norms and standards for rationalization, quality 

assurance, environmental protection, safety and communication in industry, 

technology, science, and government, as well as the public domain.DIN A” Papers: 

In the metric system paper is measured in square meters. The base measurement 

for an A0 sheet is 841 millimeters by 1,189 mm (.841 × 1189 ≅ 1 square meter). A 

DIN A1 paper is half of DIN A0, DIN A2 is half of DIN A1, and so on. 

DIN a paper sizes DIN B paper sizes DIN C paper sizes DIN D paper sizes 

DIN A0 841 × 1189 mm DIN B0 1000 × 1414 mm DIN C0 917×1297 mm DIN D0 771 ×1091 mm 

DIN A1 594 × 841 mm DIN B1 707 × 1000 mm DIN C1 648 × 917 mm DIN D1 545 × 771 mm 

DIN A2 420 × 594 mm DIN B2 500 × 707 mm DIN C2 458 × 648 mm DIN D2 545 × 771 mm 

DIN A3 297 × 420 mm DIN B3 353 × 500 mm DIN C3 324 × 458 mm DIN D3 272 × 385 mm 

DIN A4 210 × 297 mm DIN B4 250 × 353 mm DIN C4 229 × 324 mm DIN D4 192 × 272 mm 

DIN A5 148 × 210 mm DIN B5 176 × 250 mm DIN C5 162 × 229 mm DIN D5 136 × 192 mm 

DIN A6 105 × 148 mm DIN B6 125 × 176 mm DIN C6 114 × 162 mm DIN D6 96 × 136 mm 

DIN A7 74 × 105 mm DIN B7 88 × 125 mm DIN C7 81 × 114 mm DIN D7 68 × 96 mm 

DIN A8 52 × 74 mm DIN B8 62 × 88 mm DIN C8 57 × 81 mm   

DIN A9 37 × 52 mm DIN B9 44 × 62 mm DIN C9 40 × 57 mm   

DIN A10 26 × 37 mm DIN B10 31 × 44 mm DIN C10 28 × 40 mm   

 

d) JIS standards: The Japanese Industrial Standards organization (JIS) has defined two 

paper size series the JIS A that is the same as ISO 216 a size with minor differences 

in tolerances. JIS B series paper is not the same as ISO 216 B series paper, with the 

https://www.jisc.go.jp/eng/
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JIS B sizes having an area of 1.5 times the A paper size rather than the root 2 times 

the size in ISO 216. 

JIS A Sizes (mm) JIS B Sizes(mm) 

4A 1682 x 2378   

2A 1189 x 1682   

A0 841 x 1189 B0 1030 x 1456 

A1 594 x 841 B1 728 x 1030 

A2 420 x 594 B2 515 x 728 

A3 297 x 420 B3 364 x 515 

A4 210 x 297 B4 257 x 364 

A5 148 x 210 B5 182 x 257 

A6 105 x 148 B6 128 x 182 

A7 74 x 105 B7 91 x 128 

A8 52 x 74 B8 64 x 91 

A9 37 x 52 B9 45 x 64 

A10 26 x 37 B10 32 x 45 

e) BIS Standards: The Bureau of Indian Standards (BIS) is the national Standards Body 

of India working under the aegis of Ministry of Consumer Affairs, Food & Public 

Distribution, and Government of India. It is established by the Bureau of Indian 

Standards Act, 1986 which came into effect on 23 December 1986. 
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Learning Unit 2 – Perform ArchiCAD Drawing. 

LO 2.1 – Introduce basic concepts of ArchiCAD. 

Content/Topic 1: Introduction to ArchiCAD. 

A. Starting of ArchiCAD: When you start ArchiCAD, you are presented with several 

choices in how you begin your work. The Start ArchiCAD dialog offers three primary 

choices: 

− Open ArchiCAD. 

− The Start ArchiCAD dialog box will appear. Select the Create a New Project 

radio button at the top. 

− Select the Use a Template radio button under Set up Project Settings. 

− Select ArchiCAD 19 Residential Template.tpl from the drop-down list. If you 

have the International version of ArchiCAD, then the residential template 

may not be available. 

− Click on New. This will open a blank project file. 
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B. ArchiCAD Workplace: This part introduces the visible elements of the ArchiCAD 

working environment, to help you find your way around the ArchiCAD workplace and 

understand the role of each component in ArchiCAD. 

The interface provides plan, section, elevation, and detail and 3D views of the 

building and maintains a database of building information such as area calculations 

and door/window schedules. 

The components of the working environment that first loads when a project is 

opened are: the title bar, menu bar, toolbar, the floor plan window, the control box, 

the toolbox, the navigator and the info box. 
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C. Floor Plan Window: The Floor Plan Window is the basic construction area where 

most editing operations take place. It shows a representation of the current project 

as a traditional architectural drawing. The center of the ArchiCAD workplace is the 

Floor Plan worksheet. This Window plays two roles at the same time: 

− It displays a representation of the project as a traditional architectural 

drawing. 

− It is a 2D/3D modelling environment that is interactive with the 

Sections/Elevations and 3D workspace. 

The Floor Plan worksheet is like a sheet of drafting paper. However, a traditional 

mechanical drafting board is limited by the size of the paper you can fit on it, while the 

ArchiCAD worksheet can be as big as you want it to be. You can pan and zoom the 

Window within the full drawing space to obtain the best view of the work you are 

doing. 

D. Section/Elevation Window: Section/Elevation window helps to access the building 

information (sections, North Elevation, South Elevation, West Elevation and East 
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Elevation) that has been created through the process of modelling the building (on 

the floor plan window) 

 

E. 3D Window: The 3D window gives you instant feedback on the construction 

operations performed in other views and at the same time allows you to directly edit 

your model in either perspective or axonometric view.  The 3D Window is used to 

visualize the three-dimensional components of an architectural project and as an 

editing environment. You can choose to display the complete project in the 3D 

Window, or only selected parts of plan view. 

The 3D window is directly linked to the Floor Plan and to the Section/Elevation 

windows: any changes made on the Floor Plan or in any of the Section/Elevation 

windows will be visible in the 3D window and vice versa. 

 

F. Concepts of parametric: Architectural studies are gradually moving towards very 

practical approach: developing BIM (building information modeling) technology 

skills, solving problematic tasks, bringing them closer to real-life situations. 

BIM and parametric design-based software is very different in its approach and logics 

of modelling thus, while learners are prepared for real-life practice, it is generally 

understood that it is more important for them to learn BIM related programs. These, 

to name most relevant and popular, would be Revit or ArchiCAD. 

Decent BIM modelling of the building this way requires a lot of knowledge about 

construction and building practice, 

 

To make an object parametric, you have to use an input node. For example, you can create a 

Length node and connect it to the Size X input of the Block node. 
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Now the value can be set by modifying the value of the Length node. To make an object 

parameter from the Length node, open the settings dialog and set the Create Parameter 

value to true. You can also set a name for this parameter. This name will be visible in the 

Object Settings Dialog. 
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G. ArchiCAD help’s system: All GRAPHISOFT products are available on both Windows 

and Mac platforms. BIMx has both iOS and Android based version for mobile devices. 

Choose the platform according to your taste. The two versions (Mac and Win) are 

fully compatible (file formats, Teamwork) so you can even work in mixed 

environments. 

 

LO 2.2 – Use tools in ArchiCAD. 

Content/Topic 1: Tools and Palettes. 

ArchiCAD’s palettes help you construct, modify and locate elements. Each palette can 

be shown or hidden separately using the Window>Palettes command. 

The main palettes (Toolbox, Info Box,Quick Optionsand Navigator) can be enabled all at 

once, using the Window > Palettes > Show Main Palettes Only command. 
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A. Customizing the Workplace: Work Environment settings (Options > Work 

Environment) are divided into six self-contained schemes. Each scheme is a thematic 

collection of settings. 

 

− User Preference Schemes 

− Company Standard Schemes 

− Shortcut Schemes 

− Tool Schemes 

− Command Layout Schemes 

− Workspace Schemes 

If you want to customize and save your Work Environment Profile you have to be 

aware using a “button-up” method. The Work Environment builds-up as follows: 
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− First level – Work Environment: Here you can create and save the individual Profiles 

 
 

− Second level: You can manage the following Schemes here: 

• User Preference Schemes (such as 2D Redraw and Cache file location 

preferences) 

• Shortcut Schemes 

• Tool Schemes 

• Palette Schemes 

• Command Layout Schemes 
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− Third level: This is the lowest level – Here you can assign particular options to the 

Schemes. Such as: Dialog Boxes and Palettes, On-Screen Options etc. 

 
 

B. Toolbox: The Toolbox, located by default on the left edge of the Floor Plan window, 

shows a variety of tools for selection, 3D construction, 2D drawing and visualization. 

In its default shape, Toolbox does not display every single tool icon; some tools are 

grouped into Panels that can be opened or closed as well as scrolled up or down. The 

following image shows the Toolbox as it appears in the Novice mode with the two-

column display option. Examples of tools: wall, window, door, roof, beam, slab, stair, 

object, linear dimension, section/elevation, camera, text, line etc. 
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C. Info Box: An Info Box is available for each tool in the toolbox. When you activate a 

tool or select a placed element, its Info Box palette 

will display current settings for that tool/element. 

If several elements are selected, the Info Box 

displays the controls for the last selected element. 

The Info Box contains a condensed 

collection of input and parameter controls 

that are specific to the selected 

tool/element. While some of these controls 

are also available in the Tool Settings dialog 

box, the Info Box is a quicker way to access 

these controls, because it stays on screen 

while you work. 

 

 

D. Coordinate Box: The Coordinate Boxes available when working in any construction 

window. By default, it appears in the bottom of the screen. 
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The Coordinate Box: 

− Shows you the precise location of the ArchiCADcursor within both the 

Cartesian and Polar coordinate system for your drawing. 

− Enables you to enter numeric drawing coordinates for greater precision. 

− Houses the Origin, Grid and Gravity control icons. 

− Allows you to draw in both Relative and Absolute coordinates. 

 

E. Control Box: The Control Box is not visible by default. To show it, choose its name 

from the Window > Palettes menu. 

The Control Box contains a number of drawing aids in the form of icons: 

− Relative Construction Methods constrain the cursor to a defined angle or 

distance during drafting or editing. They are linked to the Mouse Constraints 

feature which helps you place the endpoints of linear elements at predefined 

angles. 

− Cursor Snap Variants control the way the current position of the cursor is 

projected. 

− The Enable/Suspend Groups switch allows you to choose between editing 

grouped elements together or on their own. 

− The Magic Wand traces the contours of existing elements in order to create 

new elements of others types. 

− The Special Snap Point definition controls automatically generate temporary 

snap points on different parts of edges and help you position elements at 

exact points or distances along lines and edges. 

 

Content/Topic 2: Cursor forms. 

Cursor is a movable indicator on a computer screen identifying the point that will be 

affected by input from the user. 

A. The Intelligent Cursor: The cursor changes shape as you work, depending on the tool 

you are using, and whether an editing/input operation is underway or not. Cursor 

variations help you identify particular nodes and edges, as an aid in editing. 
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B. Types of cursor forms. 

There are three types of cursor form whose are; 

− Search cursor: SearchCursor establishes read-only access to the records 

returned from a feature class or table. 

− Insert cursor: InsertCursor establishes a write cursor on a feature class or 

table. Insert Cursor can be used to add new rows. 

− Update cursor: UpdateCursor establishes read-write access to records 

returned from a feature class or table. Use Update Cursor to update a field 

value by evaluating the values of other fields. 

C. Function of cursor. 

- Cursor allows access of collection of records, it allows: 

▪ Iterating over the set of rows in a table. 

▪ It allows inserting new rows in a table. 

▪ It allows accessing geometry. 
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- Cursor read and writes values while looping through a cursor one record at time. 

This can allow us to edit a table by adding or deleting records. 

 

Content /Topic3: Editing and Notation. 

a) Editing: In addition to the standard editing commands (such as Undo/Rendo, Cut, 

Copy, Paste and Clear), ArchiCAD’s standard Edit menu contains more sophisticated 

transformation commands and options for editing text windows. All those 

commands are in the Menu tools or select any elements/objects and right click some 

of them are shown others are in the move tools. 

i. Undo/Redo: The undo and Redo commands allow you to undo (revert to a 

previous step) and redo a large number of construction operations. 

ii. Cut: The Cut command removes selected elements from a project and places 

them on the clipboard for future use via the Past command. The cut 

command is not available in the 3D window. 

iii. Copy: The Copy command is similar to the Cut command. Unlike Cut, Copy 

can be used in the 3D window to get image data. 

iv. Paste: With the Paste command, you can paste the contents of the clipboard 

onto the current project or a text window. 

v. Clear: Selected items are removed from project or text windows when you 

choose the clear command. As opposed to cut or copy, the cleared elements 

are not preserved on the clipboard. They are easily retrieved by Undo. 

vi. Select All: Choosing the Select All command selects all the elements of the 

currently active window that have been created by the currently active tool 

in all visible layers. 

vii. Find &Select: With this command, you can search and select elements based 

on a set of customizable conditions. The range of available criteria depends 

on the selected element type. 

viii. Drag: The Drag command allows you to move any selected construction 

element in the project. 

ix. Rotate: The Rotate command allows you to rotate any selected element in 

the Floor Plan or in the 3D window, or to rotate manually added elements in 

the Section/Elevation windows. Even in the 3D window, rotation is always 

performed across a horizontal plane. 

x. Mirror: The Mirror command creates a mirror image of any selected 

construction element on the Floor Plan or in the 3D window. 

xi. Elevate: The Elevate command allows you to move selected elements 

vertically along the Z axis. 

xii. Split: This menu command allows you to split elements along a line segment, 

arc or polygon edge. 
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xiii. Fillet/ Chamfer: This menu command opens the Fillet/Chamfer dialog box, 

allowing you to fillet or chamfer the intersection of two straight line 

segments. 

xiv. Intersect: This menu command will create an interaction of two selected line 

segments. 

xv. Adjust: This menu command adjusts (extends or trims) the endpoints of 

Walls, Beams, Arcs and Lines to a line or arc segment or polygon edge. 

xvi. Trim to Roof: You can cut gable shapes from Walls, Beams, Columns, Slabs 

and Library Parts (including Doors and Windows) to fit under roofs. 

xvii. Trim Zone: This command allows you to trim the 3D shape of Zones with 

Roofs, Slabs and Beams. 

xviii. Modify Wall (Add-on): Modify Wall is a hierarchical menu that allows you to 

modify the thickness, the reference line position and the direction of 

selected wall type elements. 

 

b) Drawing Grid: Two grid systems are provided to help you put ArchiCAD’s accuracy to 

work: The Construction Grid and the Snap Grid.   To define the snap and construction 

grids, choose the Grids & Background command in the View menu. 

 
i. The Construction Grid is used to reflect any characteristic spacing of your 

project. The construction grid could also be used to define the foundation 

footings or the column grid of a building. The construction grid can be 

enhanced with an Auxiliary Grid, which is also visible on the screen. The 
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Auxiliary Grid is often used to indicate the thickness of concrete walls or 

foundation footings. 

ii. The Snap Grid is an invisible grid that can be used to define the smallest unit 

of measurement relevant to your project. The Skewed Grid, you can specify 

a local origin that is different from the project origin, as well as a rotation 

angle. 

 

c) Setting Mouse Constraints: Mouse Constraints are editing aids that can be used as 

an alternative to Snap Guides and Guide Lines. The angle pairs they define can be 

used to lock the cursor at a particular drawing angle, by pressingShiftduring input. 

The mechanism can only be engaged while drawing or editing an element, as 

indicated by the thick rubber band line shown in the Floor Plan or the ghosted 

element contour shown in the 3D Window. It temporarily locks the cursor’s polar 

angle value in the Coordinates Palette using one of the angle pairs defined in the 

Options > Work Environment > Input Constraints and Guides. 

Using Mouse Constraints 

Constraining the drawing direction helps you precisely align or connect new elements. To 

use the orthogonal direction sets for drawing a new element: 

1. Make sure the grid snap function is disabled. 

2. Click to start drawing an element. 

 

. 
3. Move the cursor from this starting point and hold down the Shift key. 

ARCHICAD will search for the closest enabled constraint direction. 

d) Offset Controls: Creates concentric circles, parallel lines, and parallel curves. Find. 

You can offset an object at a specified distance or through a point. After you offset 

objects, you can trim and extend them as an efficient method to create drawings 

containing many parallel lines and curves. 
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e) Multiply Command: The multiply command creates any number of exact copies of 

selected elements. 

 
f) Resize Command: Choosing the Resize command allows enlarging or reducing 

selected elements either through numeric input or graphically. 
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g) Stretch Command: The stretch command is used to stretch or shrink selected 

elements. 

h) Explode Command: Explode command breaks a compound object into its 

component objects. Explode command explodes a compound object when you want 

to modify its components separately. Objects that can be exploded include blocks, 

polylines and regions, among others. 

 
i) Notation: The architecture of a software system is defined as its static structure, 

regarding packages, modules, and classes and the relationships among them. The 

best way to specify the architecture of software system is to use a 

graphical notation which shows the relations between the numerous units of the 

system. 

When examining the applicability of these modelling languages to analysis and 

design of the spectral envelope library and the VIEWENV program, several 

shortcomings are apparent: 

− Except for the now defunct OMT (Object Modelling Technique), these 

notations have no means of specifying data flow structures, but are 

specialized in describing object-oriented analysis and design. 



Page 29 of 100 
 

− It is advantageous to keep the distinction between abstract data types and 

functional module classes. In the above notations, principally all classes look 

the same. There are options to specify roles of classes, or to use adornments 

to express types of classes, but for the spectral envelope library, the 

distinction between data classes and functional modules is so important that 

it should be obvious on first sight. 

− The object-oriented VIEW program would be amenable to one of the above 

standard notations while some other standard notation could be used for the 

mainly transformational spectral envelope library. 

− As the library is written in non-object-oriented C, it is unavoidable that the 

description of the architecture for the implementation will at some level of 

detail not match the structure of the implemented code anymore. That is, the 

notation for the architecture does not have to provide for means of adding 

more detailed information; it can be kept clean and simple. 

 

j) Text: The Text tool offers multiline texts, full-scale font options, multiple styles and 

justification in any direction. 

k) Label: A label is a graphical control element which displays text on a form. A label is 

generally used to identify a nearby text box or another widget. Some labels can 

respond to events such as mouse clicks, allowing the text of the label to be copied, 

but this is not standard user-interface practice. 

 
 

Content /Topic4: Dimension. 

ArchiCAD’s dimensioning tools give you great flexibility in annotating the Virtual Building 

with your choice of measurement units and standards. Dimensions are associative, which 

means that dimension values will be updated automatically if the element they are 

associated to is modified. 

The following dimensioning construction options are available: 

• Linear Dimensions display element lengths, both curved and straight. 
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• Elevation Dimensions (a construction method of the Linear Dimension tool) 

display height values in Section/Elevation and 3D Document views. 

• Level Dimensions display height values on the Floor Plan. 

• Radial Dimensions display the radius of curved elements. 

• Angle Dimensions display the angle in degrees between pairs of lines or 

edges. 

 

A. Find & Select: 

1. Configure the Text Tool Settings 

 
Using the Text tool, you can create multiline texts with full-scale font options, multiple 

styles and alignment in any direction. 

2. Placing Text Blocks 

Before starting to type into a text block, you can determine whether it will be a “breaking” 

or “non-breaking” text block. 
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3. Label tool and settings: Labels are text blocks or symbols optionally linked 

to construction elements and 2D fills. Labels allow you to identify or 

comment elements or parts of your design. 

 
 

4. Zone tool and settings; The Zone tool is located in the Design panel of the 

Toolbox. Double-click it to open the Zone Settings dialog box. This window 

has seven panels: Name and Positioning, Floor Plan, Zone Stamp, Custom 

Settings, Model, Area Calculation and Listing and Labelling. 
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Content /Topic5: Libraries in ArchiCAD. 

A. What are Objects: Some types of construction elements and objects placed in 

ArchiCAD as the instances of predefined, parametric objects residing in external files. 

These parametric objects are stored in libraries and can be used in many projects; 

many are associated with their own tool in the Toolbox. 

B. Types of Objects: The object used in ArchiCAD include Wall End, Window, Door, 

Corner Window, Skylight, Object, Lamp and Stair. 

C. Purpose of Objects: objects contain all the information necessary to completely 

describe building elements as 2D CAD symbols, 3D models and text specifications for 

use in drawings, presentations and calculations. 

D. Object Parameters: The settings dialog boxes of Library Part type elements are more 

complex than those of basic construction elements presented.  They consist of two 

parts: 

-On the left, the browser area allows you to locate single library parts corresponding 

to the active tool in the loaded libraries, either by browsing or by entering search 

terms to find a library part by name. 

-The right-hand side of the dialog box contains settings panels, similar to the ones 

described for construction elements. 
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The panel on the right always shows the content of the folder selected on the 

browser area. If you select an element (not a folder) in the browser panel, its 

settings appear on the right-hand side of the dialog box. 

On the Floor Plan, Objects are represented by a 2D symbol while their 3D view is 

generated from the 3D script that consider the parameter choices made by the user. 

 
Some 2D only objects have special 2D symbols especially designed for use in the 

Section/Elevation window. 

 
 

E. Starting with the ArchiCAD Library: 

ArchiCAD library part is the basic item through which the CAD software ArchiCAD 

handles external dynamic content elements which are grouped into libraries. A 

library part is a file in a library. 
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F. Loading a Project Library: 

 
G. Loading an Internet Library: Is the way of adding missing library trough internet 

automatically downloaded. 
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LO 2.3 – Create virtual building. 

Content/Topic 1: Element of virtual building. 

A. Building Slab: Slabs are the horizontal building blocks in ArchiCAD. They are typically 

used for modelling floors or split levels. Slabs can be drawn either on the Floor Plan 

or in the 3D Window. The Slab Tool Settings dialog box contains five panels:  

Geometry and Positioning, Floor Plan and Section, Model and Listing and Labelling. 

At the bottom of the dialog box, as for all tools, the current layer choice is displayed 

in a pop-up menu. 

 
 

Slab Settings 

i. Double-click the Slab Tool to open the settings dialog. 

ii. The Geometry and Positioning panel contains the Slab’s thickness and 

elevation values as well as the option to show it on multiple stories. 

 
iii. In the Floor Plan and Section panel you can set the line type, fill pattern and 

pen color that will be used to represent the Slab’s outline in the Floor Plan 

and Section/Elevation Windows. 
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iv. The Model panel’s most important controls define the Materials used for 

displaying the different surfaces of the Slab in 3D view. You can use three 

different materials for the Slab’s different surfaces or click the chain icon to 

use the last selected material for all surfaces. 

 
v. The fifth panel is called Listing and Labelling and controls the handling of the 

Slab in calculations. 

vi. Finally, set the layer and when finished, click OK. 

B. Walls and Columns: 

1. The Wallis a fundamental element in the practice of architecture. When you 

create a Wall in ArchiCAD, you create the outline and hatching of a Wall in 2D 

and a solid Wall body in 3D. 
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In 3D views and Photo renderings, the look of the wall’s surfaces is provided by the 

Materials assigned to them. 

 
Wall tool and settings: The Wall Tool Settings dialog box contains four panels: Geometry 

and Positioning, Floor Plan and Section, Model and Listing and Labelling. 

2. Columns: Use the Column tool to create new columns in either the Floor Plan or 

the 3D Window.Choose the desired column attributes and geometry from the 

Column Settings Dialog box, then click to place the column into the project. 

 
 

The column settings dialog box contains four panels: Geometry andPositioning, Floor 

Plan and Section, Model and Listingand Labelling. At the bottom of the dialog box, as 

for all tools, the current layer choice is displayed in a pop-up menu. 
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C. Doors and Windows: The handling and behavior of Windows and Doors are quite 

similar; therefore, they will be described together.  In ArchiCAD, Doors and Windows 

simulate the look and behavior of real-life Windows and Doors. They are always 

placed into walls. Doors and Windows cut real, see-through openings into the wall, 

so that 3D visualizations are more accurate and lifelike. However, glass panes are 

represented as solid shapes, allowing opaque openings for standard elevations. The 

glass material lets light in and you can look through the Windows and glass Doors in 

Photo Rendered views. 

 
i. The Window,Door and Skylight tools are represented by icons within the Design 

panel of the Toolbox. The Corner Window and Skylight tools are located in the more 

panel of the Toolbox. 

 

ii. Configure the Window Settings 

a . Open the Window Settings dialog from the Toolbox. The Window and Door 

Settings dialog boxes are alike. They comprise a browser area to the left and 

a number of panels on the right. 
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− From the navigation tree on the left, select the “Metal Windows 12” 

folder. 

− A list of available windows will appear in the window below. Select 

the “W M Double Sash” window. 

 

b . The second panel is called Parameters. It contains the nominal dimensions 

of the opening as well as the set of parameters defined in the Library Part. 
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c . The third panel, the Metal Window Settings, is a wizard dialog for the most 

commonly used parameters found within the Parameters panel. Navigating 

these settings will vary from object to object. Some objects may use a Next 

and Back button while others, like this object, will use a pop-up menu. 

 
iii. Placing doors and windows 

Windows and Doors can only be inserted into Walls; they cannot be placed independently in 

the project. Placement methods are defined in the Preview and Positioning tab page of the 

Door/Window Settings dialog boxes. The Anchor Point setting decides whether you will 

place the Window or Door by its center point or its side. 

In the Floor Plan, you can place a Window or Door opening at any Checkmark or Mercedes 

cursor position on a wall. 

• To place Door and window 
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D. Stairs and HandrailsRoof Plan: 

ArchiCAD Roofs have very flexible characteristics. They can be used to create abstract 3D 

shapes meeting a wide variety of needs. In Floor Plan view, the outline of the Roofs is shown 

together with them pivot lines. This horizontal non-printing element is part of the lower 

surface of the roof. 

1. Open the Roof Settings dialog from the Toolbox and configure the settings from the 

following options. 

 

 
 

2. The Stair tool is used to place stair type library parts into the Project. The Stair tool’s 

Settings dialog box includes many of the same panels as that of the Object and Lamp 

tools: Preview and Positioning, Parameters, Floor Plan and Section, Model, and 

Listing and Labelling. These settings apply to stair objects placed directly from the 

Stair Settings dialog box, similarly to other objects. 
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In the Stair Settings dialog, select the Stair Straight RC 12 object from the Stairs 

Elements folder within Stair 12. 

 
 

E. Building Structure: ARCHICAD is a complete design suite with 2D and 3D drafting, 

visualization and other building information modelling functions for architects, 

designers and planners.  3D Modeling software (is a 3D CAD interface specially 

developed for architects capable of creating various kind of building forms). 
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F. Furnitures And Equipment: Objects are predefined complex parametric elements 

that can be freely placed in the project. 

1. Object settings 

✓ Double-click the Object Tool to open the Object Settings dialog. 

✓ From the Folder View open ArchiCAD Library > Furnishing > Kitchen 

Cabinet. Select the “Cabinet Base Corn-L”. 

✓ The Preview and Positioning panel includes simple navigation 

controls, elevation input for the Object or Lamp as well as a Preview 

Area that displays the 2D symbol, the hidden line front view, the 

hidden line axonometry, the 3D shaded axonometry, the predefined 

preview picture or theoptional information notes of the selected 

Object or Lamp. 

✓ The second panel is called Parameters. It contains the dimensions of 

the Object as well as the set of parameters defined in the Library Part. 

✓ The other panels are Door, End panel, Counter. These panels will 

change for each object and is designed to display graphically the most 

commonly used parameters. 

✓ The following panel is Kitchen Cabinet Settings. 

✓ When finished with the settings, click the OK button. 

 

 
G. Ceiling and lights:You need to create a set of views for your ceiling plans to show the 

locations of your lights. Ceiling plans are graphically different from regular floor 

plans. Because of this, we need a separate set of views that have their own model 

views. This situation calls for the creation of a clone folder. 

Cloning a folder is a complete copy of a viewpoint category from the project map, 

such as stories, sections, or elevations, with its own view settings saved. Here is how 

to create one for your ceiling plans: 

1. From the view map, click on the Clone a Folder button. The Clone a Folder 

configuration window will appear. 
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2. In the Identification panel, click on Stories, change the Name setting to 

Custom and enter CD Ceiling Plans in the text box. (CD stands for 

construction documents). 

3. In the General panel, change Layer Combination to Reflected Ceiling Plan, set 

the Scale to 1/4" = 1'-0", the model view options to Reflected Ceiling Plan, 

and Renovation Filter to 04 New Construction. 

4. In the 2D/3D Documents panel, change the zooming to Fit in window. 

5. Click on the Clone button. 

6. Find the new folder in View Map; select it and drag it up to the position just 

below CD floor plans. 

 

Light fixture objects in ArchiCAD are called Lamps. Now that you have your ceiling views 

ready, you can insert the lamp objects you need to light the inside of your house. They are 

as follows: 

1. Open the second-floor view under the CD Ceiling Plans folder. 

2. Click on the Lamp tool on the Toolbox palette (located under the More 

panel). Click on the Lamp setting button on the Info Box palette. 

3. Navigate to 26 Electrical | 26 51 00 Interior Lightingand select Ceiling Lamp. 

4. Under the Parameters panel, change the Style to Type 2. 

5. Under the Parameters panel, click on Show Text, and then enter the letter A 

in the text box. 

6. Place one in the center of each bedroom. 

The following screenshot shows the Lamp option: 
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H. Molding and Panels:Panel molding is a decorative molding originally used to trim 

raised panel wall construction. Panel molding adds depth and style to any wall and 

comes in many patterns and styles. Restorers Architectural panel molding is made 

from lightweight urethane that is primed and molded to create beautiful historic and 

new designs. Urethane can be cut, drilled, nailed and screwed just like wood and can 

be used outdoors as well. Acanthus, egg and dart, rope, dentil, traditional, Bradford, 

and many other designs are available. 

 
 

I. Zones and Section/Elevation: Double-clicking the Section tool    opens 

the Section Settings dialog box, which consists of seven panels: General, Marker, 

Marker Head, Model Display, Story Levels, Story Handle Marker Custom Settings and 

Grid Tool. Some of the panels’ settings concern the Floor Plan appearance of the 

Section Line, while others control the contents of the Section/Elevation window. 

 

Configure Section Settings 

Open the Section Settings dialog from the Toolbox and configure the settings per the 

following: 

 
 

J. Site Layout: 

I'm trying to make a site plan of my projects in ArchiCAD, But I couldn't figure it out 

how is the best way. is there a view that shows the projection of all model, using the 

projected of the stories I couldn't do it, how did you do it? 
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K. Creating Library Parts:This step-by-step walkthrough shows how to create a static 

library (.lib file) for use with C++ apps. Using a static library is a great way to reuse 

code. Rather than re-implementing the same routines in every app that requires the 

functionality, you write them one time in a static library and then reference it from 

the apps. Code linked from a static library becomes part of your app, you don’t have 

to install another file to use the code. 

This walkthrough covers these tasks: 

− Creating a static library project 

− Adding a class to the static library 

− Creating a C++ console app that references the static library 

− Using the functionality from the static library in the app 

− Running the app 

 

To create a static library project 

a. On the menu bar, choose File, New, Project. 

b. In the left pane of the New Project dialog box, expand Installed, Templates, 

Visual C++, and then select Win32. 

https://msdn.microsoft.com/en-us/library/ms235627.aspx#BKMK_CreateLibProject
https://msdn.microsoft.com/en-us/library/ms235627.aspx#BKMK_AddClassToLib
https://msdn.microsoft.com/en-us/library/ms235627.aspx#BKMK_CreateAppToRefTheLib
https://msdn.microsoft.com/en-us/library/ms235627.aspx#BKMK_UseLibInApp
https://msdn.microsoft.com/en-us/library/ms235627.aspx#BKMK_RunApp
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c. In the center pane, select Win32 Console Application. 

d. Specify a name for the project for example, Math Funcs Lib in the Name box. 

Specify a name for the solution for example, Static Library in the Solution 

Name box. Choose the OK button. 

e. On the Overview page of the Win32 Application Wizard dialog box, choose 

the Next button. 

f. On the Application Settings page, under Application type, select Static 

library. 

g. On the Application Settings page, under Additional options, clear the 

Precompiled header check box. 

h. Choose the Finish button to create the project. 

 

LO 2.4 – Apply Updating layout, printing and plotting. 

Content/Topic 1: Purpose of linked drawing: 

Linked drawings allow us to create drawings from data that is changeable and most 

conveniently stored within geocoded tables or queries.Manifold can create linked 

drawings from geometry data in tables or from geometry data fetched or created by 

queries. Using geometry data in tables and then creating linked drawings from that data 

allows storing drawings within tables in a fully read/write and editable way. However, at 

times we deal with simple, non-geometry data in tables and would like a simpler way of 

displaying such data in drawings. 

Like all linked drawings, the linked drawing is created from geometry data; however, in this 

case the geometry data from which the linked drawing is created comes from the 

intermediate query. The automatically-created query takes data from the coordinate 

columns in the table and creates geometry data necessary for a linked drawing. There is 

nothing special about this process that could not be done manually, if we were so inclined. 

The only magic in this process is that if we try to link a drawing from a table that contains no 

geometry data (Manifold can see right away if a table contains geometry data or not), then 

Manifold assumes we want to create a linked drawing from a geocoded table and so it 

launches the appropriate dialog. When we use that dialog to specify which columns are to 

be used as coordinate columns (that is, for the longitude and latitude columns or X and Y 

columns), then Manifold knows what columns to use in the query it writes for us. 

To create a linked drawing from a geocoded table: 

1. Choose File - Link - Drawing and open the desired database file or connect to the 

desired data source. 

2. Choose the table desired and check the desired fields. Specify the fields that 

contain latitude and longitude values (by default, the system will guess that any 

fields named "Latitude" and "Longitude" are the fields to use. Press OK. 

 

http://www.georeference.org/doc/linked_drawings.htm
http://www.georeference.org/doc/linked_drawings.htm
http://www.georeference.org/doc/geometry_in_tables.htm
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Four new components will appear in the project: 

·      A linked table - This linked table is a way of linking the table data from the 

geocoded table that will provide the data for the linked drawing. 

·      A query - This query transforms the ordinary, geocoded data in the coordinate 

columns into geometry data from which the linked drawing will be created. 

·      A linked drawing and the linked drawing's table - The linked drawing is like any 

drawing, except it is created dynamically from the data within the geocoded 

table. 
 

Uses for Linked Drawings 

 

Linked drawings allow us to create drawings from data that is changeable and most 

conveniently stored within geocoded tables or queries. The classic use for a linked drawing 

is within a Manifold IMS application such as a vehicle tracking web site. Suppose we have a 

fleet of trucks or ships or other vehicles and we would like to display the location of each 

vehicle on a web site map. Suppose we can acquire the location of each vehicle through 

some other application that receives location data from a GPS in each vehicle and places it 

into a table in our database. Showing the location of each vehicle in Manifold is as easy as 

creating a linked drawing using that table. 

 

Content/Topic 2: Updating linked drawings: 

The Linked objects sidebar gives users the ability to quickly access all linked content to see if 

anything is outdated and update all the content with a single click. 

This means that the drawing placed on the layout will be updated automatically when the 

layout is activated (brought to front or selected for output). Automatic updates also occur 

before publishing. If a drawing comes from a different source than the currently opened 

project file, then ARCHICAD will check whether it requires updating or not, and perform an 

update if necessary. 

Although a linked drawing that appears in the project pane is normally read-only, it is 

usually possible to edit that linked drawing by editing the linked table within the project 

from which it is created, which will end up editing the table in the data source as well. We 

could also edit the original data source. For example, suppose we have a linked drawing 

created from a query that grabs data from a table in an external database file. We could 

change that linked drawing by editing either the external table or by editing the query. 

Linked drawings normally are used not for the purpose of interactive editing through the 

Manifold console graphical user interface but rather to display visually data from some 

database table. The assumption is that the database table from which the drawing is 

http://www.georeference.org/doc/map_server_overview.htm
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created will be edited through the database management system or by other programs 

which will change the data in the table. 

A. Save special command. To update the data in a multiple charts or tables: 

− In Docs or Slides, at the top click Tools > Linked objects. 

− A sidebar will open on the right, at the bottom click Update all. 

Note: Click Update next to specific objects to update them individually. 

 

Content /Topic 3: Printing and plotting from ArchiCAD. 

A. Printing:You will learn that printing in ArchiCAD offers you a robust array of features. 

There are three ways in which you can print something from ArchiCAD. You can use 

the Print command, Plot command, or Publisher using a preconfigured publisher set. 

The Print command is typically used for your small format printing, such as 1'' x 

17''and smaller. The Plot command is typically used for everything larger than 1'' x 

17''. You can print a view, single sheet, or multiple sheets at a time or just the area 

within a marquee in a view. 

 

B. Setting up to print or plot: Before you plot anything on a large-format printer 

(known as a plotter), you need to configure the plot setup for your plotter typethe 

connection port/path, sheet size, and location of your spool folder, as follows: 

1. Go to the File menu and select Plot Setup. The Plot Setup window will 

appear. 

2. Select the manufacturer (make) of your plotter from the top drop-down list. 

Then, select the model number from the second drop-down list. If your 

plotter makes and model does not appear in the list, use Hewlett Packard, 

HP Design Jet 650C. 

3. Set your paper size category and size designation. 

4. Click on the Setup button under the Connection heading and set it to connect 

to your plotter. 

5. Click on the Select button under the Spool Folder heading and set it to a 

location where you would want to save your plot files. 

6. Click on OK. 
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C. Page setup:Setting up for printing using a small-format printer with the Print 

command is a bit simpler than the plot setup. It assigns the printer, paper size and 

orientation: 

1. Go to the File menu and select Page Setup. The Page Setup window will 

appear. 

2. Select your printer from the Name list. If the printer you want to use is not in 

the list, then click on the Network button and browse connect to a new 

printer. 

3. Then, set your paper size and orientation. 

4. Click on OK. 
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D. Plotting a layout: For our first printing task, let's plot a single full-size sheet with the 

Plot command, as follows: 

1. Open the A-101 1st FLOOR PLAN layout from the Layout Book palette. 

2. Go to the Filemenu and click on Plot.The Plot Layout window will open. 

3. Under the Destinationheading, select Plotter. 

4. Under the Sourceheading, select Active Layout. 

5. Under the Resizeheading, select Custom. If the value is less than 100 percent, 

then don't worry; it is acceptable because there is a margin to accommodate. 

6. Under Margin Options, select Use Plotter Margin. 

7. Under Plot with… you can select whatever is appropriate for your plotter and 

needs, such as Color, Grayscale, or Black and White. 

8. Under the Arrangement heading, you will see a blue rectangle representing 

the layout graphics inside a black rectangle that represents the paper's edge. 

9. Finally, click on the Plot button. 
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E. Printing a layout (to fit): Now, let's print that same layout to a small format printer, 

scaled to fit within a letter size print: 

1. Keep the same layout open from the preceding exercise. Go to the File menu 

and select Print or press the key combination of Ctrl + P. The Print Layout 

window will open. 

2. The printer will be identified at the top of the window. If it is incorrect, then 

click on the Page Setup button and assign the correct printer. 

3. Under the Source heading, select Entire Layout. 

4. Under the Size heading, select Fit to Page. 

5. Under the Arrangement heading, the blue rectangle should fit inside the 

black rectangle (there should only be one black rectangle). 

6. Compare the other settings to the following screenshot. 

7. Finally, click on the Print button. 
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Content /Topic4: Printing and plotting from Plotmaker. 

Is there a way to have Plotmaker print the date when printed and possibly the source of the 

file on the edge of the sheet every time one plots or prints from Plotmaker? I have 

discovered how you do this in ArchiCAD but not in Plotmaker. 

Just put the right Autotext on your master sheet. You can insert it into a text area using 

the Edit > Autotext > and select from the popup list or you can type the placeholder text 

directly (once you know what it is). 

You can print files in the following ways: 

− From the File menu you can print with the following options: scaling, clipping, 

displaying the plot on the screen, or sending the plot directly to the printer. You can 

also print shaded images from this menu. You can create plot files of the current 

object (sketch, part, drawing, assembly, or layout) and send them to the print queue 

of a plotter. The plotting interface to HPGL and PostScript formats is standard. 

− Use the Distributed Batch utility to create a command file of print or plot files 

without having to choose from the interactive menus. The command file contains a 
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list of objects to plot. For example, you can submit the job at the end of a workday, 

and the plot files are created and plotted offline. 

− Hidden lines appear as gray for a screen plot, but as dashed lines on paper. 

− You cannot plot when the option Use Fast HLR is checked in the Environment dialog 

box. 

− When Creo Parametric plots the system line fonts, it scales them to the size of a 

sheet. It does not scale the user-defined line fonts, which do not plot as defined. 

− You can use the configuration file option use software line fonts to make sure that 

the plotter plots a user-defined font exactly as it appears in Creo Parametric. 

− With the CROSS-SEC menu active, you can plot a cross section from Part or Assembly 

mode. 

− You can write plot files in Calcomp, Gerber, HPGL2, and Versatec format. 

− For the HPGL2 driver to print a screen capture of OLE objects, the printer must 

support the HP RTL extension. 
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Learning Unit 3 – Perform AutoCAD Drawing. 

LO 3.1 – Introduce AutoCAD. 

Content/Topic 1: Introduction to AutoCAD. 

Engineering graphics is the process of defining an object graphically before is constructed 

and used by consumers. Previously, this process for producing a drawing involved the use 

of drawing aids such as pencils, ink pens, triangles, T- squares, and so forth to place an 

idea on paper before making changes and producing blue-line prints for distribution. The 

basic principles and concepts of producing engineering drawing have not changed, even 

when the CADs are used as a tool. For this case AutoCAD is the Computer Aided Design 

under consideration. 

The main objective of this course is to provide participants with: 

− Basic theoretical and practical knowledge/skills to produce 2D technical/engineering 

drawings with the aid of AutoCAD. 

− Understanding of concepts, tools and methods for drafting and preparing layouts in 

AutoCAD. 

There are four workspaces supplied with AutoCAD:  2D drafting and annotation, Initial 

Setup workspace, AutoCAD Classic, and 3D Modelling. 

 

Content/Topic 2: Advantages of AutoCAD. 

The following are the advantages of AutoCAD. 

1. Accurate and Reduces Errors – The principle on which AutoCAD works is a dynamic 

Engineering model. This model blends design and production drafting together 

which allows the changes to be made to any part of the design at any point of time 

in the entire project. These results in error reduction and fewer chances of mistakes. 

Furthermore, the designs which are made digitally always have room for 

enhancements and improvement. 

2. Save Time & Money – With a specific and user-friendly interface and workflow, 

AutoCAD works speedily which saves the time of the designer. AutoCAD support 

documentation tools that not only increase productivity but also help the designers 

and architects to streamline the designs and documentation workflows. It also 

provides solutions to implement modifications in the projects, thus reducing the 

time taken. It is an efficient program that undertakes the work process of the 

designer and helps in saving time and money and reducing errors. 

3. Easier Data Transfer – Using AutoCAD in Architect Designing has made it easier to 

share files with multiple people simultaneously. It is not easy to work on heavy files 

https://www.educba.com/autocad-tools/
https://www.educba.com/autocad-tools/
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and then share them without any data loss. But, this software has made it easy to 

upload the designed data on the internet and sharing it with numerous other 

designers. 

4. Controllable in nature – This advantage of AutoCAD supports the scanning feature 

for the data. This technique helps in measuring the quantity of the materials used. It 

also helps in calculating the exact cost of the products. Eventually, it helps in 

managing production and post-production processes. 

5. Database for manufacturing – AutoCAD allows in creating manufacturing data such 

as materials required for components, dimensions, and shape of the models, 

product and component drawings. This helps in creating and managing a wide 

database which is an important part of the production process. 

6. Easier Import/ Export of files – AutoCAD Inventor supports file import and export 

feature. AutoCAD allows the users to import models from Inventor and it also 

manages to do it quite easily and speedily. AutoCAD also supports various other 

tools and features that boost the productivity of the program. Some of them being; 

PDF support, compatible with Autodesk 360, social media sharing, AutoCAD WS, 

DWG Convert and many more. AutoCAD also supports PRESSPULL operations which 

allows the users to create surfaces, solids and offset curves with much ease. These 

meshes are dynamic in nature and can easily be manipulated. The designers can 

easily develop physical 3D Frameworks of their designs with the 3D printing 

capabilities of AutoCAD. 

7. Apply Point Clouds – Point Cloud is a large collection of points resulted by 3D laser 

scanners to create a 3D presentation of default structures. The users can join these 

point clouds to use as a starting point for their designs. 

8. AutoCAD inhibits the Layering feature. This feature allows the user to hide or show 

specific details of a complicated complex group of drawings for clear understanding. 

9. Another advantage of using AutoCAD is user can calculate Mass, Area, volume, 

Center of Gravity in no time. This program has an Auto- Dimensioning feature that 

helps in designing easy and accurate sketches. The users can also generate 2D 

drawings from 3D models. 

10. Commands like Fill, Hatch, Section lines, chamfer, and fillet makes AutoCAD one-stop 

solutions to many designers as these operations are impossible in manual drafting. 

11. It also supports Image tracing feature. This helps in a digital tracing of conventional 

diagrams and drawing. 

AutoCAD supports PDF import enhancements. It also has an SHF text recognition 

tool which converts the geometries imported from PDF text to Text objects which 

can be edited more conveniently. 

 

 

 

 

https://www.educba.com/install-autocad/
https://www.educba.com/careers-in-3d-printing/
https://www.educba.com/careers-in-3d-printing/
https://www.educba.com/career-in-designing/
https://www.educba.com/career-in-designing/
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Content /Topic3: AutoCAD user interface. 
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a) The Menu Bar: In either workspace, Menu Bar provides an easy way to access most 

AutoCAD commands. This bar helps the designer to open the documents, to save the 

work done, to cut, to copy, to paste, Edit, View, Insert, and so on. 
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b) Toolbars: Activating the AutoCAD Classic workspace will automatically display 

toolbars. The toolbar also contains the tools for modifying the drawn objects such as: 

move, rotate, trim, offset and so on, this is mostly located on the right side of the 

AutoCAD interface. The following image shows the Standard, Workspaces, Layers, 

Properties, Styles, and Draw toolbars displayed. 

 

c) Status bar: Let’s talk abit about the status bar which gives you information at a 

glance about the state of the drawing. 

 
i. SNAP (F9): Restricts cursor movement to specified intervals. 

ii. GRID (F7): Displays a grid in the current viewport that is plotted. 

iii. ORTHO (F8): Constrains cursor movement to the horizontal or vertical. 

iv. OSNAP (F3): Sets running object snap modes. Osnap let you accurately 

select specific points on an object, such as endpoints or midpoints. 

 

d) The command windows: This command helps the designer, to write the command for 

drawing or for modifying an object. 

 
Open or Close the Command Window 

− Click View tab Palettes panel Command Line. Find. 

− Press Ctrl+9. 

− At the Command prompt, enter command line or command line hide. 

 

e) Dynamic Input: Dynamic input provides a command interface near the cursor in the 

drawing area. When dynamic input is turned on, a tooltip displays dynamically 

updated information near the cursor. When a command is in progress, you can 

specify options and values in the tooltip text box. 
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Content /Topic4: Set units of measurement and angles. 

Before you start drawing, it’s important to decide what one drawing unit represents in the 

real world. Architects in the United States typically equate one drawing unit with 1 inch in 

AutoCAD. You need to choose a unit type that matches your country’s industry standard. 

 

A. Set units of Measurement: Before beginning an AutoCAD drawing a drafter must 

first determine the appropriate drawing units for the type of drawing being created. 

- Click the New button on the Quick Access toolbar. Click the arrow button next to 

the Open button in the Select Template dialog box and choose Open with No 

Template 

- Type UN and press Enter to bring up the Drawing Units dialog box. UN is the 

command alias (abbreviation) of the UNITS command. Most commands have 

aliases that minimize typing. 
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- Select Architectural from the Type drop-down menu. I’m using Architectural in this 

book, but you should select the unit type that fits your industry when working 

professionally. Metric users should select Decimal length units. 

- Click the Length Precision drop-down menu and select 1/8g (or 0.0 for metric). Set 

Angle Type to Decimal Degrees and Angle Precision to 0.0. 

- Click the Insertion Scale drop-down menu and select Inches (or Centimeters for 

metric). Click OK to close the Drawing Units dialog box. 

 

B. Set angles convention: On the following table, the designer can be able to set the 

units and the angles. You can specify that positive values of angles are measured 

either clockwise or counter clockwise, and the direction of angle 0 (usually East or 

North). You can enter angles in grads, radians, or surveyor's units or in degrees, 

minutes, and seconds. 

If you use surveyor's angles when specifying polar coordinates, indicate whether the 

surveyor's angles are in the north, south, east, or west direction. For example, to 

enter the relative coordinates for a property line that is 72 feet, 8 inches long with a 

bearing of 45 degrees north, 20 minutes, 6 seconds east, enter @72'8"<n45d20'6"e. 
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LO 3.2 – Create geometric objects. 

Content/Topic 1: Creation of geometric objects. 

With large or complex drawings, you can create and preserve geometric objects that serve 

as references for creating new objects and checking existing objects. 

Reference geometry, also known as construction geometry, typically includes lines, circles, 

points, lines, and rays. Reference geometry can be used for defining the basic envelope of a 

2D design, interference boundaries, centerlines, and critical locations such as the center of 

gravity in a rotating part or a benchmark on a map. 

For 3D modeling in AutoCAD, reference geometry includes 2D profiles, axes of rotation, 

paths of travel, and 3D wireframe models. 
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− Benefits of Reference Geometry: Use reference geometry to create other objects 

using Copy, or Offset and Trim. When you work from existing geometry, you receive 

the following benefits: 

• Facilitate creating, modifying, and reconstructing areas within a drawing 

• Use object snaps, object snap tracking, and polar tracking from reference 

geometry 

• Avoid proliferating an error to other geometric objects 

• Check locations, rotations, and distances easily 

• Find and correct incorrectly sized or misallocated objects 

− Manage with Layers: Keep your reference geometry on dedicated layers. If you 

choose layer names using a numeric prefix such as 00, 01, and so on, you can ensure 

that the layers will appear at the top of the layer list. 
 

Content/Topic 2: Use coordinates and coordinates systems. 

You can draw objects in Euclidean space using the following coordinate systems: Cartesian, 

polar, cylindrical, and spherical. (The last two are rarely used). 

− Cartesian coordinates are useful for drawing rectangles with specific length and 

width measurements. 

− Polar coordinates are used most often for drawing lines with specific lengths and 

angles, with respect to horizontal. 

Once you learn coordinate system syntax, you can use the systems interchangeably to draw 

accurately in any context. In the Cartesian system, every point is defined by three values, 

expressed in terms of distances along the x-, y-, and z-axes. In two-dimensional drawings, 

the z-coordinate value of all objects is 0, so objects are expressed solely in terms of x- and y-

coordinates. 
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A. Use Absolute Coordinates: Coordinates can be absolute or relative, no matter which 

coordinate system is used. Let’s first focus on drawing a line using absolute 

coordinates. To begin, open the fi le Ex02.5-start.dwg from this chapter’s companion 

fi les. 

− Click the Line tool on the Draw panel. The prompt in the Command window 

reads as follows: LINE Specify first point: Type 0, 0 and press Enter. The origin 

point of Euclidean space has coordinates 0 in x and 0 in y, which is written as 

0, 0. 
− Now the prompt in the Command window reads as follows: LINE Specify next 

point or [Undo]: Type 3’, 0 (or 90, 0 for metric) and press Enter. Right-click to 

finish the LINE command. 

− Save your work. Your model should now resemble Ex 02.5-end.dwg,which is 

available among this chapter’s companion fi les. 

 

B. Use Relative Coordinates: Calculating where every object is in relation to the origin 

point (which is what absolute coordinates require) would be far too cumbersome in 

practice. 

Therefore, relative coordinates are used more frequently. Let’s explore how-to use 

them. To begin, open the fi le Ex02.6-start.dwg from this chapter’s companion fi les. 

− Click the Line tool on the Draw panel. Click an arbitrary point in the middle of 

the living room. The coordinates of the point you clicked are unknown; 

thankfully, with relative coordinates you won’t ever need to find out what 

they are. 

− Type @3’, 0 (or @90, 0 for metric) and press Enter twice. 

− Press Enter to repeat the last command. You’ll see this prompt: LINE Specify 

first point: 

− Right-click in the drawing canvas and hold (for longer than250 milliseconds) 

to open the context menu. Select the first coordinate value from the Recent 

Input menu. 
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− Type @0, 6’ (or @0,180 for metric) and press Enter. A line measuring 6f (or 

1.8m) is drawn vertically along the y-axis. 

− Type @-3’, 0 (or @-90, 0 for metric) and press Enter. Type @0, -6’ (or @0, -

180 for metric) and press Enter twice to complete a rectangle. 

− Click the Rectangle tool on the Draw panel and then click an arbitrary point at 

the bottom of the living room. The prompt reads as follows: RECTANG Specify 

other corner point or [Area Dimensions Rotation]: 

− Type @3’, 6’ (or @90,180 for metric) and press Enter. The same rectangle 

that you more laboriously drew with lines is already done. 

− Save your work. Your model should now resemble Ex02.6-end.dwg, which is 

available among this chapter’s companion fi les. 

 

C. Use Polar Coordinates: Polar coordinates are another useful way of measuring 

Euclidean space. In polar coordinates, points are located using two measurements: 

the distance from the origin points and the angle from zero degrees. East is the 

default direction of zero degrees. 
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Let’s explore how to use polar coordinates. To begin, open the fi le Ex02.7-start.dwg. 

- Click the Line tool on the Draw panel. Click an arbitrary first point in the living 

room; then type @3’<45 (or @90<45 for metric) and press Enter to end the LINE 

command. 

- Press Enter to repeat the last command. Click an arbitrary first point, move the 

cursor up and to the left, type 3’(or 90 for metric), and press Enter twice. A 3’(or 90 

for metric) line is drawn at an arbitrary angle. 

- Press L and then press the spacebar. Click an arbitrary first point, type @4’<180 (or 

@120 <180 for metric), and press Enter. The line is drawn to the left from the first 

point because 180 degrees is the same direction as angle zero but leads in the 

opposite direction. 

- Type @3’<–90 (or @90 <-90 for metric) and press Enter. Negative angles are 

measured clockwise from angle zero by default. Press C and then Enter to close the 

3:4:5 triangles you’ve just drawn. 

- Type UCSICON and press Enter. UCS stands for user coordinate system. You, the 

user, can change the coordinate system’s orientation. Type on and press Enter. An 

icon indicating the directions of the positive x- and y-axes is displayed in the lower-

left corner of the canvas. 

 
- Type UCS and press Enter. The prompt in the Command window reads as follows: 
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UCS Specify origin of UCS or [Face Named Object Previous View World X Y Z-axis] 

<World>: 

There is much you can do with the UCS, but here you will simply rotate the UCS 

about its z-axis (the axis coming out of the screen). Type Z and press Enter. 

- Type 90 and press Enter to rotate the coordinate system. Observe that the UCS 

icon has changed to reflect the new orientation 

 

- Type PLAN and press Enter. The prompt in the Command window reads as follows: 

PLAN Enter an option [Current UCS World] <Current>: The option in the angled 

brackets, <Current>, is what you want, so press Enter to make this selection. The 

house is reoriented with respect to the current UCS. 

 
 

- Click the Line tool on the Draw panel. Click an arbitrary first point in the living 

room, type @3’ <45 (or @90 <45 for metric), and press Enter twice to end the LINE 

command. The new line has a different orientation with respect to the original line 

you drew in step 1. 

- To restore the current coordinate system to its original state, called the world 

coordinate system (WCS), type UCS and press Enter twice. Then type PLAN and 

press Enter twice more. The plan is oriented to the WCS as it was initially. 
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- Save your work. Your model should now resemble Ex02.7-end.dwg, which is 

available among this chapter’s companion fi les. 
 

Content /Topic 3: Enter direct distance (modifier command. 

With direct distance entry, you can quickly specify a point relative to the last point you 

entered. At any prompt for a point location, you move the cursor first to specify the 

direction, and then enter a numeric distance. 
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Content /Topic4: Use precision tools. 

By far, the most important way for you to specify precise locations on objects is to use 

object snaps. In the following illustration, several different kinds of object snaps are 

represented by markers. Object snaps become available during a command whenever 

AutoCAD prompts you to specify a point. 

There are several precision features available, including 

− Polar tracking. Snap to the closest preset angle and specify a distance along that 

angle. 

− Locking angles. Lock to a single, specified angle and specify a distance along that 

angle. 

− Object snaps. Snap to precise locations on existing objects, such as an endpoint 

of a polyline, the midpoint of a line, or the center point of a circle. 

− Grid snaps. Snap to increments in a rectangular grid. 

− Coordinate entry. Specify a location by its Cartesian or polar coordinates, either 

absolute or relative. 

The three most commonly used features are polar tracking, locking angles, and object snaps. 

Recheck your geometry to catch mistakes early. Enter the DIST command (or just DI) to 

measure the distance between any two points in your model. 

 

Content /Topic5: Management of geometric objects. 

A. Extract or Calculate Geometric information from objects: The inquiry and 

calculation commands can provide information about objects in your drawing and 

do useful calculations. 

− Obtain Distances, Angles, and Point Locations: You can obtain information 

about the relation between two specified points or multiple points; for 

example, the distance between points or their angle in the XY plane. 
To determine the relation between points, you can display the 

• Distance between them. 

• Angle between the points in the XY plane. 

• Angle of the points from the XY plane. 

• Delta, or changed, X, Y, and Z distances between them. 

The ID command lists the X, Y, and Z coordinate values of a specified point 

− Obtain Area and Mass Properties Information: You can obtain the area, 

perimeter, and mass properties defined by selected objects or a sequence 

of points. 

You can calculate the area and perimeter of a sequence of points. You can 

also obtain the area, perimeter, and mass properties of any of several types 

of objects. 

http://docs.autodesk.com/ACD/2011/ENU/filesACR/WS1a9193826455f5ffa23ce210c4a30acaf-4ad4.htm#WSc30cd3d5faa8f6d815cda3fffc2d607ac-8000
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B. Control the user coordinate system: About Controlling the User Coordinate System 

(UCS). 

− Use the PLAN command to rotate the view such that the X and Y axes are 

horizontal and vertical. 

− Restore the UCS to being concurrent with the World Coordinate 

System (WCS) with the UCS command. 

 

LO 3.3 – Modify objects. 

Content/Topic 1: Overview of modifying objects. 

The drawn objects always require the modification at every step made. Most of 

architectural drawings have a big set of features and most of the time to simplify the work 

modification commands may have to be used. 

Many modification techniques and AutoCAD commands that you use in 2D drafting can be 

applied to 3D modelling. In addition, a specialized set of 3D editing commands is available in 

AutoCAD. All these AutoCAD commands are in the Modify panel on the Home tab when the 

3D Modelling workspace is current. 

Although you can use the Move, Rotate, and Scale commands to modify 3D objects, they 

can sometimes give unexpected results in 3D. Enter the 3DMOVE, 3DROTATE, and 3DSCALE 

commands, which all use a gizmo or grip tool when a non-orthographic view is current. 

 
 

 

 

https://www.dummies.com/programming/autocad/how-to-use-the-rotate-command-in-autocad-2014/
https://www.dummies.com/programming/autocad/how-to-use-the-scale-command-in-autocad-2014/
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Content /Topic 2: Modify menu tools. 

The icon of modify command located on the Modify toolbar or Modify panel of the home 

tab of the ribbon. Although you may find yourself using a few of the commands on this 

toolbar, such as Move, Trim, Offset, Copy, Remove and so on. 

 

1. Remove (erase) objects: To remove the drawn object, 

− Select by clicking continually from right side to the left side of the drawing. 

− Right click. 

− Erase. 
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2. Move objects: 

 

− Select the Move icon from the Modify tool or the modify panel of the Home 

tab. 

− When prompted to select objects, pick the objects you would like to move by 

selecting them either individually or with a window and press < Enter> 

− When prompted to specify the base point pick a point on the object. The base 

point is like handle on the object to be moved. 

− When prompted to define the displacement pick a point at specific distance 

from the original object or enter absolute, relative, or polar coordinate value. 
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3. Rotate objects: 

 

 

 

− Select the Rotate icon from the Modify tool or the modify panel of the Home 

tab. 

− When prompted to select objects, pick the objects you would like to rotate by 

selecting them either individually or with a window and press < Enter> 

− Wen prompted to specify the base point, select a point on the object. The 

base point is pivot point around which the rotation will occur. 

− Wen prompted to specify rotation angle enter a value and press < Enter> 



Page 75 of 100 
 

 
 

4. Copy, Offset or Mirror objects: 

 

− Select the copy icon from the Modify tool or the modify panel of the Home 

tab. 

− When prompted to select objects, pick the objects you would like to copy by 

selecting them either individually or with a window and press < Enter> 

− When prompted to specify the base point, pick a point on the object. The 

base point can thought of as a handle o the object to be copied. 

− When prompted to define the displacement, use the mouse top pick a point 

in the drawing window located at a specific distance from the base point of 

the original object, or enter absolute, relative, or polar coordinates, to define 
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the point where you want to place the copy. You can continue to place copies 

by defining more points. Press < Esc>or< Enter>to end the command. 

 

 

 

 

− Select the Offset icon from the Modify tool or the modify panel of the Home 

tab. 

− When prompted to specify the offset distance, type the value of desired 

offset distance and press < Enter> 

− When prompted to select object to offset, select the object by left-clicking. 

− At the specify point on side to offset prompt, pick a point on the side of the 

object where you want the new object to be created. 
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− Select the Mirror icon from the modify toolbar or the mofify panel of the 

Home tab. 

− At the select objects prompt ,pick the objects you would like to mirror by 

selecting them either individually or with a window ,and press < Enter> 

− When prompted to sprcify first point of mirror line, define the first point of 

the mirror axis by selecting a point in the graphics window ,where you want 

the mirror axis to begin. 

− When you are prompted to select the second point of the mirror line ,select a second 

point in the graphics window defining the other end of the mirror axis. 

− When prompted to erase source objects [Y/N] ,press < Enter>to retainthesource 

object (the prompts default is No), or type a Y and press < Enter>to erasethe 

object being mirrored. 
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5. Change the size and shape objects (stretch command): the icon of stretch command 

can be used to lengthen or shorten objects .it can also distort objects. To stretch 

objects, you can either drag the base point to a new location or enter coordinates. 

- Select the stretch icon from the Modify toolbar or modify panel of the 

HOME tab. 

- When prompted to select objects, pick the object you would like to stretch 

with a crossing window (define the window by picking from right to left) and 

press < Enter> 

- When prompted to specify base point, select a point located on the object to 

be stretched. 

- When prompted to specify second point, define the point you wish the object 

to stretch to by picking a point with the mouse, or entering absolute, relative, 

or polar coordinate values. 
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6. Create fillets, Chamfers or Breaks in objects: 

 

This command is use to create fillets (rounded inside corners) and rounds (rounded outside 

corners) o the objects. The polyline option creates fillets and rounds on the corner of 

polyline. 

− Select the Fillet icon from the modify toolbar or modify panel of the HOME tab. 

− Type R (for radius) and press < Enter > 

− When prompted o specify fillet radius, enter the radius of the fillet and press < Enter 

> 

− When prompted to select first object, pick the first line to be filleted near the end to 

be filleted. 

− When prompted to select second object, pick the second line to be filleted. 
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Chamfer command: The icon of chamfer command is used to bevel the corners of objects. 

The distance option allows you to enter a chamfer distance for both sides of the bevelled 

corner. The angle option allows you to enter a distance and an angle for the bevelled corner. 
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− Select the Chamfer icon from the modify toolbar or modify panel of the 

HOME tab. (select the drawn arrow next to the Fillet icon and choose from 

the drop-down list). 

− Type D (for distance) and press < Enter > 

− When prompted to specify first chamfer distance, enter the distance to bevel 

the first edge and press < Enter > 

− When prompted to specify second chamfer distance, enter the distance to 

bevel the first edge and press < Enter > 

− When prompted to select first line, pick the first line to be bevelled near the 

end to be bevelled. 

− When prompted to select second line, pick the first line to be bevelled near 

the end to be bevelled. 

 

7. Modify Splines:The icon of spline (SPL) command shown helps to crates non-uniform 

spline curve.Spline line command tutorials: 

− Select the spline icon from the draw toolbar or draw panel of the HOME tab. 

− When prompted to specify first point or [object], type 2,2and press< Enter > 
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− When prompted to specify next point, type #4,5(with dynamic input on)and 

press< Enter > 

− When prompted to specify next point, type #6,2 and press< Enter > 

− When prompted to specify next point, type #8,5 and press< Enter > 

− When prompted to specify next point, type #10,2 and press< Enter > 

− When prompted to specify next point, press< Enter > 

 
 

LO 3.4 – Apply Notes, Hatches and dimensions. 

Content/Topic 1: Hatches. 

The term hatching refers to filling bounded areas with solids, patterns, and/or gradients. 

You create hatching in the AutoCAD program to indicate transitions between materials and 

to improve the readability of drawings in general. Hatching with solid fill, patterns, and/or 

tonal gradients can transform staid line drawings into attractive illustrations. 

Every hatch area is defined by a boundary containing the solid fill, pattern, or gradient. You 

can determine the boundary either by picking a point on the drawing canvas or by selecting 

an object or set of objects. 
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A temporary tab called Hatch Creation appears on the ribbon. This tab will remain active 

while you configure the hatch object you are creating. Click Solid in the Pattern panel, and 

turn off Associative mode if it is on by clicking its button in the Options panel. 

 

Content/Topic 2: Notes and labels. 

Create notes, labels, bubbles, and callouts. Save and restore style settings by name. You 

create general notes using the MTEXT command (or enter MT in the Command window), 

which stands for multiline text. The multiline text tool is available on the Annotation panel. 

 

After you start the MTEXT command, you are prompted to create a "text box" with two 

diagonal clicks. 
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The exact size of the text box is not that important. After you specify the text box, the In-

Place Editor is displayed and you can easily change the length and width of the note before, 

during, or after typing the text. 

 
All the usual controls are available in the In-Place Editor, including tabs, indents, and 

columns. Also notice that when you start the MTEXT command, the ribbon temporarily 

changes, displaying many options such as text styles, columns, spell checking, and so on. 

• To exit the text editor after you finish entering the text, click anywhere outside it. 

• To edit a note, simply double-click it to open the text editor. 

Tip: You can use the Properties palette to control the text style used for one or more 

selected multiline text objects. For example, after selecting five notes that use different 

styles, click the Style column and choose a style from the list. 

 
 

Create a Text Style 

As with several other annotation features, multiline text provides a lot of settings. You can 

save these settings as a text style using the STYLE command, and then you can access the 

text styles you've saved by clicking the drop-down arrow on the Annotation panel. The 

current text style is displayed at the top of the drop-down list. 

To create a new text style, click the Text Style control as shown. 
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When you create a new text style, you give it a name, and then choose a font and a font 

style. The order in which you click the buttons is shown below: 

 
 

Content /Topic 3: Dimensions. 

When adding dimensions on the drawing the designer has to consult the “menu bar” and 

click on “dimension”. Here the designer can Work with all types of dimensions. 

Essentially there are two types of dimensions: Size and Location dimensions. The overall 

width and height of the part are size dimensions, the diameter of the hole through the part 

is also a size dimension, but the location of the center point of the hole is defined with 

location dimensions. Generally, the features of an object are located on the object with 

location dimensions and described with size dimensions. 

Dimensional information may also include notes that provide information necessary to 

manufacture a machine part. For example, notes that specify the type of material from 
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which the part is manufactured. Or special processes to be performed on the part during 

manufacture (heat treating or polishing), are included in the field of the drawing. If the 

notes included on the designer’s input are omitted from the technical drawing, the part may 

not be manufactured as the designer intended. 

 

A. Identification of basic concepts of dimensioning 

The below figure shows the terminologies used to refer to the elements of 

dimensioning. Locate the   dimension and extension lines noted in the figure. 

Extension line extends out from the features of the object that are being 

dimensioned. Dimension lines are drawn between the extension lines and typically 

terminate in arrowheads that point to the extension lines. Dimensions lines contain 

text that denotes the distance or angle between the extension lines. Now locate the 

Leader in the figure. 

Leader point to the features of the part and are used in notations that describe the 

feature, like the diameter of a hole or the radius of an arc. Later in this chapter you 

will be required to relate the terminology shown in the below figure to the 

corresponding setting in AutoCAD’s Dimension style manager dialog box to create 

an AutoCAD dimension style. 
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B. Create dimensions: many possible dimensions types are available like: linear 

dimensions, aligned dimensions, arc length dimensions and so on. 

The AutoCAD dimension toolbar containing all the commands necessary to add 

dimensions to a drawing as shown in the figure below. These commands are also 

located in the dimension panel of the Annotate tab of the ribbon. In the follow 

figure each dimension command icon is labelled with its function. 
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i. Linear dimension command: the icon of the linear dimension command is shown in 

the figure below. This command displays the linear distance between two selected 

pints. This option is used to dimension both vertical and horizontal features 

 

ii. Aligned dimension command: the icon for aligned dimension command is shown as 

bellow; this command is used to display the length of an angled line. 
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iii. Arc length command: the icon for arc length command is as bellow. This command is 

used to denote the length dimension of an arc or polyline arc segment. 
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iv. Ordinate dimension command: this icon of Ordinate dimension command is used to 

denote distances along X- and Y-axes relative to a defined origin point (usually 

labelled 0, 0). 
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v. Angular dimension command: The icon for angular dimension is used to denote the 

angle between two features of objects. 
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LO 3.5 – Proper control the properties of object. 

Content/Topic 1: overview of the object’s properties. 

The properties command is used to display or change the properties of an object or group of 

0bjects, such as color, line weight layer, line type, a line type scale. This is a very useful 

feature of AutoCAD. Begin this command by choosing the arrow next to Properties at the 

bottom of the icon from the palettes panel of the view tab of the ribbon, or by selecting the 

properties icon from the palettes panel of the view tab of the ribbon. Next, select an object I 

the drawing window and a properties palette will open that displays the objects properties. 

In the follow example, the circle has been selected and its properties are displayed in the 

property’s palette. 
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Content/Topic 2: Display and change the objects properties. 

To change the properties of the circle, select the field in the palette next to the property to 

be changed. For the follow example, the circle is on the visible layer. Clicking on the field 

next to the layer properties displays a list of available layers. Selecting a different layer from 

the list moves the circles to the selected layer. The circle’s other properties such as line 

weight, or line type scale, can be changed in a similar fashion. Other information about the 

circle, such as its diameter, radius, circumference, area and center location, can be located 

or changed in the property’s palette under the Geometry heading. 
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To close the palette properties, left-click the Xin the upper left corner of the palette. 

Content /Topic3: Work with layers. 

In AutoCAD drawings, lines and others entities are drawn on layers. Think of layer as sheet 

of clear glass layered one on top of the other. A layer can have its own color, line type or 

lineweightassigned to it. 

When you begin an AutoCAD drawing from scratch, it consists only one layer, layer zero (0), 

if more layers are needed there must be created. 

A. Creation of new layer. 

− Click on the layer properties manager icon located in the layers panel of the 

home tab on the ribbon. 
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− When the layer properties manager open palette open, click the new button. 

 
− Select the new layer and replace its default name, Layer 1, with new name. 

− Repeat step 3 to create more layers, when all the new layers created click OK, 

and shows the layer created for mechanical drawing. 

 

Content /Topic 4: Work with colors. 

When setting the layer color, you have to follow this, 

− Click on the layer properties manager icon located in the upper left corner of the 

layer panel of the home tab on the ribbon. 

 
− Select the layer to which you want to assign anew color and click on the color 

assigned to the layer in the color column in the diagonal box. 
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− When the select color dialog box open, select the desired tile from the color palette 

and click OK. 

 
 

Content /Topic5: Work with lines types. 

Setting layer line type is performed as follow, 

− Click on the layer properties manager icon located in the upper left corner of the 

layer panel of the home tab on the ribbon. 

 

− Select the layer to which you want to assign a new line type and click on its line type 

name in the Line type column. 
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− The select line type dialog box will open. If you don’t see the desired line type listed 

click the Load bouton. 

 

− The load or reload line type dialog box will open. Scroll through the line types and 

select the line type you wish to load and click OK. 
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− Select the newly loaded line type from the selected linetypedialog box and click 

OK.The new line type will be assigned to the layer selected in step 2. 

 

Content /Topic 6: Control line weights. 

Line weight control is performed as follow, 

− Click on the layer properties manager icon located in the upper left corner of the 

layer panel of the home tab on the ribbon. 

 
− When the layer properties manger palette open, select the layer to which you want 

to assign new line weight, and click on the line weight setting in the 

lineweightcolumn. 

 
− When the line weight dialog box open, scroll through and select the desired line 

thickness in which you want the layer to be printed and click OK. 
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Page 100 of 100 
 

Reference(s): 

1. AutoCAD 2016 and AutoCAD LT 2016, Scott Onstott, Published simultaneously in 

Canada (ISBN: 978-1-119-05918-9). 

2. AutoCAD 2016 andAutoCAD LT 2016, George Omura & Brian C. Benton engineers, 

Published simultaneously in Canada (ISBN: 978-1-119-04483-3). 

3. Basics Architecture, Farrelly, L, 2008. 184 p, 01: Representational techniques. Laus-

anne: AVA Publishing SA. 

4. Differentiating parametric design: Digital workflows in contemporary architecture 

and construction, Wortmann, T., Tuncer, B. Vol, 52, 2017, pp. 173−197, Design 

Studies. 

5. Technical drawing 101 with AutoCAD, Douglas smith professor–Antonio Ramirez 

professor emeritus-Ashleigh Fuller Adjunct professor, (2019), Copy right 2016-SDC 

Publication. 

6. https://blogs.autodesk.com/autocad/hitchhikers-guide-basics-of-autocad-notes-and-

labels/on 27th July 2020 

7. https://knowledge.autodesk.com/support/autocad/getting/started/caas/CloudHelp/

cloudhelp/2019. on 27th July 2020 

8. http://support.ptc.com/help/creo/creo_pma/usascii/index.html#page/fundamentals

/fundamentals/fund two sub/About Printing and Plotting.html. on 25th July 2020 

9. www.pdfdrive.net, on 25th July 2020 

 

https://blogs.autodesk.com/autocad/hitchhikers-guide-basics-of-autocad-notes-and-labels/
https://blogs.autodesk.com/autocad/hitchhikers-guide-basics-of-autocad-notes-and-labels/
https://knowledge.autodesk.com/support/autocad/getting/started/caas/CloudHelp/cloudhelp/2019
https://knowledge.autodesk.com/support/autocad/getting/started/caas/CloudHelp/cloudhelp/2019
http://support.ptc.com/help/creo/creo_pma/usascii/index.html#page/fundamentals/fundamentals/fund two sub/About Printing and Plotting.html
http://support.ptc.com/help/creo/creo_pma/usascii/index.html#page/fundamentals/fundamentals/fund two sub/About Printing and Plotting.html
http://www.pdfdrive.net/

